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General Tips & Tricks

Navigation Tips & Tricks

Calendars & Date fields
o When you need date from the last few days of the previous month or the first few days of the

next month when you are on a calendar you can click on the dates that are grayed out without
needing to click back a full month.
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Today 12 Months | | Cancel

If you need to get back to Today’s date quickly, click the Today box on the Calendar.
On a date field on a screen with a gray background, the + and - keys can be used to go forward
(+) or backward (-) one day at a time.

O
O

e Recent Records
From most Inquiry screens, click on the File Menu the last 10 records accessed will be listed

under Recent Records. You can click on the record you wish to return to.

o

File | Edit  Search  Filters Settings Period File | Edit Search  Filters  Settings
[E] Print 4 [E] Print »
2  Refresh Data Ctrl+R 2 Refresh Data Ctrl+R

Recent Records Recent Records

01-10210 Cash - Savings 1st State Bank
10-60-430 Utility Repairs

91-16502 Vehicles

01-10100 Cash Allocated To Other Funds

3.103.01 (Baker, Brent)

2.149.01 (Bates, William 5.)
1.104.01 (Smith, Dr. Ronald T.)
1.101.01 (Acme Manufacturing)

Close Ctrl+F12 Close Ctrl+F12
Exit Caselle Connect® Exit Caselle Connect®
File | Edit  Search  Filters  Settings Other Docw
[B] Print 4
‘D  Refresh Data Ctrl+R
Recent Records
P-14-0009 (Residential - Single Family Dwelling)
5-21-0001 (Sign)
P-14-0016 (Residential - Single Family Dwelling)
P-14-0001 (Residential - Single Family Dwelling)
Close Ctrl+F12
Exit Caselle Connect®
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e Entry Defaults
o Entry Defaults are available in the following places: Modify Existing Vendors (AP), Modify
Existing Customers (AR), Modify Existing Business (BL), Chart of Accounts (GL), Modify
Existing Inventory (MM), Modify Existing Employees (PR), Modify Existing Jobs( PA), Modify
Existing Locations (UB), and Modify Existing Customers (UB). Default values can be setup so
they will populate automatically when adding a new record.
* |n Modify, go to File > Defaults

File | Edit Search DocumentManagement Zoom  Help
H save Ctrl+S

£ Options.. ayeble - > Vendors = > Medify

" Defaults Shift+F8 " "m]_

i|08|é&H|E=-

Close Ctrl+F12

e

Exit Caselle Connect®

= The screen will clear unless defaults have previously been set.

Caselle Connect® - > Accounts Payable ~ > Vendors = » Modify Existing Vendors

[ Casclle Connect® || Vendor Inqury || Modify Existing Vendors (3|
Vendor
Vendor: 644 -
Vendor Entry Defaults Remittances Recurring Invoices  Direct Payment Attachments  User-Defined  MNotes
Vendor number: Alert message:
Name: || - @
Secondary name: ||
Address line 1:
Address line 2: ‘ |
City: [nyord | 1099 information
State/Province: wI ~ Type: None ~
Zip/Postal code: Delivery paint: l:l ID number; l:l
Country/Region: | | Name: ‘ =]
Telphone s [ Secondery name: | =1
Tekphonez [ | State code: -
Email: ‘ |
Website: [ =]
Contact: [ 1]
Wendor type: ‘Nurma\ v |

[ Use this vendor in Materials Management

Activation date: l:l
Termination date: :l

= Enter the defaults for any field, then click save and answer Yes to save the defaults.

Save Defaults X
0 Okay to save defaults?
Yes No Cancel

o You can control entry defaults in Accounts Payable’s Enter Invoices on a vendor-by-vendor
basis. To change the entry defaults, follow these steps:
* In Accounts Payable, go to Vendors | Modify Existing Vendors.
= Navigate to the vendor you want to change.
= Click on the Entry Defaults tab.
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= Can set the defaults for Item description, GL account, Department, Terms, Shipping
address, Sales tax rate, and Description history.

e Inquiry Filters
o You have the ability to filter the list of vendors or customers that appear in Vendor Inquiry or
Customer Inquiry. Follow this example to create a filter that only shows active customers in
Customer Inquiry:
= |n Customer Inquiry, click on the down arrow next to the Filter button on the toolbar.

¥ <[] - 2 O @

ammercial Custarmers

Active Customers Only

=TT

Direct Pay Custormers
Equal Pay Custorners

Yeteran Search

% Manage filters...

e ey

= Click on Manage filters...
= Click the Add a new filter button.

4

= Enter a Filter name:.

= Click the Save this filter checkbox.

= Also, click on Set as default if you want this filter to default every time you enter
Customer Inquiry.

= Double-click on Column

|§ Colurnn |

= Find Customer.Final bill date in the list. Double-click on this field to move it to the right
side of the screen.

= Click OK.

= Double-click on All next to Customer.Final bill date.

|? Column | Value |
Customer.Final bill date  All % E
= Click on Operators and select {is null}.
= (Click OK.
= (Click OK.

This filter is now available in the drop-down list when you click the down arrow next to the
Filter button on the toolbar. You can add as many filters as you want.
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Hyperlinks

Blue text indicates a hyperlink to another process

Caselle Connect® ~ > Community Development ~ > Permit Inquiry

Pesmit: | |permit MR of 34 oo

P-14-0001 3150 W Main 5t Balance due 136
Residential - Single Family Dweling Anycity, WI Total fees 1,967.17
Issue permit

Permit  Transactions Desaiption of Work  Property Contractors Fees  Approvals Inspections Conditions
Permit  Additional Fields  Attachments  Notes

Applicant information
Mame:  Allen, Lee

Residential - Single Famiy Dweling

. Account Payable

*  From Purchase Order Inquiry
* to Vendor Inquiry using Vendor Name
* to Invoices using the Invoice Number or
+ to Requisition Inventory using Requisition Number
* From Requisition Inquiry
» to Vendor Inquiry using Vendor Name
* to Purchase Order Inquiry using Purchase Order Number

. Animal Licenses

*  From Inquiry
» to Cash Receipting through Account balance

Community Development

*  From Permit Inquiry

* to the next step in the Permit process
» Examples, approvals, issuing permit, inspections, completing permit

» to Property Inquiry using Property Address
» to Cash Receipting using Balance due

* From Property Inquiry
* to Cash Receipting from Balance due in Permits or Violations tab
» to next step in the Permit process from Permits tab

General Ledger
*  From Account Inquiry
* to Journal Inquiry using the Journal Code

Utility Management
* From Customer Inquiry
* to Modify Locations from the Location Address
» to Cash Receipting from Balance Due
* to Email from the email address
+ to Meter Maintenance from the Meter Number in the Meter tab
* From Service Order Inquiry
* to Customer Inquiry from the Customer
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Zoom

Zoom is available throughout the system to enlarge the text within Caselle.

e To activate the zoom option, click on the zoom menu at the top and select the zoom percentage or
use ctr + or ctrl — to zoom in and out.

Zoom | Help

Zoom In Ctrl + (+)
Zoom Qut  Ctrl + (-)

il~] 100% Ctrl+0
125%
I 150%
175%

200%

Custom.... 100%

e Zoom default can be setup in Security > Setup/Modify User Rights by user as well.

Caselle Connect® - > System Management - > Security - > Setup/Modify User Rights

|‘ Caselle Connect® ” Setup/Modify User Rights Q|
User: |

User:  AnnetteS Annette Spencer

User  Databases MNotes

Mame: ‘Annetbe Spencer | Connect  Connect Online

Metwork user ID: ‘ | | Al

Active Directory:

Password: Change...

[] require user to change their password at login
Activate user [ Lock login
[ Motify user if program updates are available

=) Caselle Connect®
El- Accounts Payable
\?I- Accounts Receivable
\él- Animal License

EI- Asset Management

Zoom
100% \:|:O$|i| Zoom

él- Badkflow Management
EI- Business License

\él- Business Tax Collection
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Tabs & Split Screens

Caselle screens can be split by clicking on a tab and dragging it out of the lineup.

Caselle Connect® - > Utility Management = > Customer Inguiry

Close |88 04302022 -~ 4 B &-BE v-E-% 2 € @9 F: &
Caselle Connect® = > Utility Management = > Customer Inquiry
1.101.01 Acme Manufacturing 15385 780 W Customer Inqu\ry
Customer: | || Fie FEdit Search Fiters Settings Period Other Documen
110101 Acne Manufacturing 15385 780 W Close & | 043072022+ 4 B &-|E|7-|a-%
4661 Monaco Street PO Box 230
1101 801-333-9090 Payson WI 84651 Customer: I
1.102.01 Norma's Hair Salon
10 Terrace Court
Displa 10 Terrace Court
play  Compare History Transactions Customer Services Location Meters Backflow Contracts Loans Cef 1102 08 252
Detal  Balances Chart
— <
Meter ID ‘ Register ‘ P’S;‘t"e“ | Previous Read | (;;’;"t ‘ Curre}taead Dispiay Compare History Transacons Customer Services Location Meb
3647 18KW Reading 03/27/2032 22557 Detall | Balances Chart
| Meter ID Register P’S"i‘fﬁ“s ‘PrevmusREad ‘ Cg";”t | ¢
01563258 High Compou... 03f27/2042 1745 04/p0f2022 24 al a
(T, B 389526KW  Reading  03/27/2022 55712
\ ) 35620041 Reading  03/27/2022 540

Summarize by
(O Detsl @ service () Service category

.00 Payments

395.95

Summarize by
(O Detsil (@ Service () Service category

When a tab is click & dragged out of the tab lineup an icon will appear that looks like a table and
benches. This allows you to pick how you want to split the screen. You can add your tab at the

top, bottom left or

right depending on which side you highlight.

File Edt Search Fites Setngs Period Other fanagement  Zoom  Help Fie Edt Seach Fites Settings Period Other DocumentManagement Zoom  Help
TR B PR s 4= R A | TS0 T0D WD o (w2 - < BB B|Y-E-%22 000 % 7
(CaselleConnect® ~ > Utity Management = > Customer Inquiry Caselle Connect® ~ > Utiity Management ~ > Customer Inquiry
[[Femitina [[Property o ] [[customer inqury @] & (g
[ e N (L o= Gustaner I G TW «E o= v m ||$
e 15385 70 W s L0201 NomsHar S 1695 Commerce Ave N 2o || F
3561 Monzco POBox 290 e oy 10 Temace Court oo meat |l
1101 5013335080 Payson W1 84651 o3jos/2022 ana44a252 Aty W 86855 u osszz wear ([
Dislay  Compare  Hstory Transactions  Customer  Services  Location  Meters  Backfon Contracts  Loans  Certiication  CreditHistory - Supplemental =
Dipley | Compare | Hstory | Transactions | Customer | Services | Locaton | Meters  Backfow | Contracts | Loans | Certfcaion Credt History._ Supplementl Detal | paances Chart =
et | solnces hart " = — &
] veterD | Regiter | PR | previousRead | SO | CurentRead |Days|  Mitpler | Usoge | Amaunt Servie =
= =T [(rewn [ oo [ 5 = %
MetwrD | Regster | PIVS | previusmead | Cuen =l I 2631 F
e = fi R e e (L £
aeia e - () [BI8-[B[v-8-%|8[2(0]09 O Detal ® senviee O servie ategon L
0156325 igh Compou.. 03/27/2022 1735 ospoe22 | i ] ! : tesers =
Low Compou o T = = =
110201 Norma'sHair Saon 1695 Commerce Ave [ Caselle Connect® | Permitingury | Property Inaury__| Custorer Inqury_ ) =
10 Terrace Court
Customer: cstomer < oz
e P ety w509 [ =S Mk ] ]
L0101 Acne Menufacurag 15385 720 W tbalance: 5.5
Diplay Compere History Transactons Customer Servies  Locatn Meters Sackfow  Contract Loans POBox 290 e oqpopZ B
Detal galonces Chart 101 e01:333.090 Payson Wl 5451 ot 0308022 308
vewn | nga | Peio | premanon [ S0 [ ammness [oms|
Disley | Compare | Hstory  Transactions  Customer _ Servies  Locaton Meters Backfow | Contracts | Loans | Cerfication | CredtHstory Spplemental
W9 Resing 032702 sz Detal Bl Chart
3041 Readg 0327202 50 -
[ sstecn | poictor | Prevous [ pypincpmt | Corment toead | sitcker | ticace | scnt
9595
Sunmariz by Summarize by
O petal @ service O Service category. O petsl @ service O service category
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Fie Edt Sech Fiters Setings Period Other [ Document Vsnsgement | Zoom  Help Fle Edt Serch Ftes Setings Peiod Other [DocumentNanagement | Zoom  Help
Close |8 | o4/307202  + 4 BE- B Vv-a-% 292 0 e9 F: 3 7 | [close |8 oaz02 - 4 Be- 3 V-8-%2 292009 £ 7
Caselle Connect® = > Utiity Management ~ > Customer Inquiry || caselle Connect® + > Utiity Management + > Customer Inquiry |
) Pemitingury | Property tnaury ) customer ey @) l(g| |[(cmdecomens ) [ [customer naury 3] @
Gustoner S A _Jorm b b |[2] [ custoner Gustomer VI Jotm » o || customen Customer g
[ : 0 0 $
Acme Manufacturing sBSTROW 5 L0101 Ace Manufacturing 1538574 169'S Commerce Ave =
2561 Monaco Steet POBox 250 os0022 2651 Homsco Sest PoBox (=
01 01333903 Payson W1 g6 ote/zz2 ] e i v — 5]
Y [ ewer [conpma ey L faaaciors [ cowcnes [ srvms [ cocaon v [ s [ ]| vter [compar sy fcancons T comonmr v [ oo o [ astom T ] | 3
Doy Compare History Transactins Customer Serves Location Meters Backfon  Gentracts Losns  Certfication Credt istory Suplenentl L i
§| | ool seances ot Oet paances Chart gl
Detal  gatnces Chart & [
| Prevous | prevas | Gurent | Gurrent Prevous | prevous | Curent | Curent
, MeterD | Regster Doy | Maller Vet | Regeter Oays | mstper | | ||
e e = F ¥ Readng 0302 2597 [2] || [osscn resdng o3z s 3
547 eading 272 s KEA'(' % 35620041 Reading 03/27/2022 540 2]
| (B | omsus  wnco. oz vmovwmz e # iow i
0156255 righ Compou.. 0327/2022 1735 oympmz 2 1000 00 vise = ek - o ll
Low Compe CustomerInquiry I, 0
File Edit Search Fiters| Sefige  Period  Other n o
Cose |88 |02z - S| @ || v - -2 2009 1
Customer: Customer ||
L1201 Normas o Ssen 1655 Commerce Ave
10 Terace Goet
102 sos40252
OS2y Compare History Trarsactirs Customer Servces Locaton Meters Sackfon Contacts Losns | Cercaton CrediHitor
Detai  Balances Chart ™
[ T e —— e sy e oy | |
‘Summerize by e L T [ G || &I W O]
O detsi @ servee O Service cateary FoRKW | Readng g = S Summarzeby Summarze by
3620041 Readng o2 e O Detal @ Service O Service category O Detai @ Service O Service category
Cityof Anycity sdmin] Chalata

If it is dragged to the center, it will go back into the tabs at the top. You can also put it back by
double clicking the header when it is a separate window.

Fle Edt Sech Fites Setings Peiod Other DocumentMansgement Zoom Help
&z -4 |88V a-% 2009

~ > Utty Management = > CustomerInguiry

Close

& ¢ §

Casele Connect®

[ Cosete Cores

Fie Edt Sech Fites Seffirgs Period Qther DocumentManagement Zocm  Felp

i

Close

w3002

-

B|&-B(v-a-»

12|00 @9

|

Caselle Connect® + > Utiity Management ~ > Customer Inquiry

@l . . : -
e pm— o | [(Casele Comect® | Custower Tngury | Custoner Inquiy (] Ofg
T 1 & [ ustamer [ Custoer K oz b |2
e — [ Leor Nornai ar 531 1695 Conmerce ave Accauntbance: wa || F
10 "erace Court Balance due:  430/2022 20631 _
ooy onpwe story | Tiarsacors | ustome | Servees | Locaton et Backow | Conacs | Losns | Certaton redt sty Suplenental E I sos-ssaaisz anyaty i o5 Lestpamert 522 w657 [
Detal  gences Chert gl J
g‘ Disday  Comsare History Transactions  Custoner Services ocaton  Meters Backfiow Contracts  Loans  Certication Crecit History _ Supplenenta 2
r Regsts bpore Previous Reac gxet urrent Reac ays Multiplier sage | Amount rvice E
weter 1o e | Petes | om= GmentResd | oars o [ e = o E
s = o =t Meter ID Register e Previous Read Eloiaal? Qurrent Read Days Multiplisr Usage  Amoutt Service
[ Date =
ousn_rcomomed a8 1745 ooz e 1000 &l | o reis CErr] e 00 | Becrc
n e 362004 Readng o370z 540 00 Water
Fle Edt Serch Ftessuties e Zoom  Hep L]
00 abige
Close 8 0 £ % 2009 00 Miscelareous
Gusarer [ (Gmtoner 00 shueff
10201 Norma's Hair Salon 1695 Commerce Ave 00 salsTax
00 penaly
o A W1 S 00 ~otal charges
Dy | Compare Hitory | Transactrs | Cstomer ccaton Metes Bacion | Convacts Loars | Corsfcaton Gredt Hatory Suplinenal 2631 Previousbilance
Detl drces Chrt 00 paments
g | Pevos | o = Qrent | ouren e 1 00 Adusiments
D [ Rewer | 7 cvomread | G [ curennead o | wtper | usoe) | Anc
pr— Reaing e 72
O oot ® servee Reang oy 0
iy ofAnycity sdmin| Cratats] ‘ e

If clicking and dragging is not your thing, you can right click on the tab you want to move and have
the option to “Float”, to create a “New Horizontal Tab Group” or to create a “New Vertical Tab

Group”.

Caselle Connect®

= > Utility Management - > Customer Inquiry

10 Terrace Court
1102

Display  Compare
Detail

History Transactions

Balances Chart

Customer

&0
E New Herizontal Tab Group

|’ Caselle Connect® || Customer Inquiry H [oT T ———
Customer: Close
1.102.01 Morma's Hair Salon

Close All But This

Float

[T Mew Vertical Tab Group




Float will bring the tab out in it's own window.
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Edit Search Fiters Settings Period Other Document Management Zoom  Help
Close |38 | 0430202+ B == &A= AF Ik M=) "] I
Caselle Connect® =+ > Utility Management » > Customer Inquiry
[Caselle Comect® | Customer Inury Ofg
Customer: [ customer vl (b Totm  » om llg
1.101.01 Acme Manufacturing
2661 Monace Strect
ll[lli File Edit Search Filters Settings Period Other Document Management Zoom Help
Close |8 0430202 - « » W |B-|B|7-E-% (22 |O|©@O
Diplay Compare History Transactions  Customer §
Detal  Balances Chart Customer: Customer
r 1695 Conmerce Ave
Previous
‘ veter D ‘ Register ‘ s ‘
XS Readng o3/27/2022 Anyelty W 85353
Display Compare History Transactions Customer Services Location Meters Backfow Contracts Loans Certification Credit History Supplemental
01563258 Figh Compound  03/27/2022 Detai | alances Chart
Low Compound Ie
Frevious curent
‘ Meter D ‘ Register el ‘ Previous Read ‘ o ‘ CurentRead  [Days | Multpler ‘ Usage | Amat
389526KW Reading 03/27/2022 55712
35620041 Reading 03/27/2022 540

The “New Horizontal Tab Group”

will put the tab at the bottom of the screen.

File Edit Search Fiters Settings Period Other DocumentMansgement Zoom  Help
Close | @ | 04307202 - 4 &3 7-8-% 29 69 %
Caselle Connect® + > Utility Management + > Customer Inquiry
((caselle Connect® | customer Inuiry e
Customer I e i B bW |2
1.101.01 Acme Manufacturing 15385 780 W Account balancs 395.95 ;E
4661 Monaco Street PO Box 230 Balance due:  04/30/2022 395.95 '
1101 801-333-9050 Payson WI 84651 Last payment: 03/08/2022 379.08- |'_|J
5
Display Compare History Transacons Customer Services Location Meters Backfiow Contracts Loans Certification CreditHistory Supplemental %
Detall  Balances Chart Py
v v/ &
Meter 1D Register Sl Previous Read Current Current Read Days Multiplier Usage | Amount Service p
ate Date o
‘ 395.95 | E
E
Summarize by H
) Detal @ Service (O Service category —
[ Customer Inquiry
Customer; Customer vl 4
1.102.01 Norma's Hair Salon 169 S Commerce Ave Account balance:
10 Terrace Court Balancedue:  04/30/2022
1102 608-444-8252 Anycity WI 88888 Last payment: 03/15/2022 196.47-
Display Compare History Transacons Customer Services Location Meters Backfiow Contracts Loans Certification CreditHistory Supplemental
Detal  Balances Chart
Meter ID Register Frevious Previous Read Current CurentRead | Days Multplier Usage | Amount Service
ate Date.
[ 26,51 |
Summarize by
O Detal @ Serviee O Service category
The “New Vertical Tab Group” will put the tab at the bottom of the screen
File Edit Search Filters Settings Period Other Document Management  Zoom  Help
Close | 38 | 04302022 -~ 4 HE- B v-a-e 20 e9 e
Caselle Connect® + > Utility Management ~ > Customer Inquiry
[caselle Connect® | Customer nqury [ [=] [ customer nqury (] = (=
Customer: [ | customer R boMl || customer: [ ] | customer PRI o bW ||2
1.101.01 Acme Manufacturing 1538514 1695 Commerce Ave Account balance: Al &
4661 Monaco Street POBOX Balance due:  04/30/2022 & N
Tins ons 777 nnon pi [ |t s n2tsE i e
< > || IT»IJ
Display Compare History Transactions Customer Services Location Meters Backfiow Ccl¢|* || Display Compare History Transactions Customer Services Location Meters Backfow cd*[* ||| &
Detail  Balances Chart Detail  Balances Chart Iy
&
Previous | Previous | Curent | Current Previous | Previos | Curent | Current L
Meter D | Regster | 57Ot o ‘ e ‘ s ‘ Days | Multiolier MeterD | Register | FiEYt P S ‘ R ‘ Days | Multiplier ®
.
364718KW Reading 03/27/2022 22597 389526KW Reading 03/27/2022 55712 pul
35620041 Reading 03/27/2022 540 g
01563258 High Co... 03/27/2022 1745 04/20/2022 750 24 1.0000 E
Low Co... 0 10 ]
v
ml W plilila; W
Summarize by Summarize by
) Detal @ Service (O Service category () Detall @ Service () Service category
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To put the tab back, right click on it and select “Move to Previous Tab Group”. Or you can click and
drag it to the middle like discussed above. If you double click on it, it will float and then you will
need to double click on the header a second time.

File Edit Search Filters Settings Period Other | Document Management | Zoom  Help
Close | | 04730202 - 4 B2 v-E-% 22609 £ &
Caselle Connect® - > Utility Management ~ > Customer Inquiry
[ Caselle Comect® | Customer Inquiry 3] [*] [ custom = 1 =] (_T
Close 3
Customer: [ [customer MR of 28 »obl Customt I H 4 of 28 »oMo|[2
Close All But This a
1.101.01 Acme Manufacturing 15385: 4 u Account balance: 206.31 - F
4861 Monaco Street PO Box Balance due:  04/30/2022 306,51 (i
1ane one 233 nnnn n. 2 n Float [y s AoieEiannan ane =
< > < > IS-IJ
Display Compare History Tramsactons Customer Services Location Meters Backfow Cd *|* | | Display M smiemE e Eery r Services Locaton Meters Backflow cd*[* || =
E
Detaill  Balances Chart Detal  Balances Chart =1

To close a tab, you can either click the =/ on the tab or right click and select Close from the menu.

Caselle Connect® - > Utility Management - > Customer Inquiry

" Caselle Connect® ” Customer Inquiry H Custd = [ ver
Customer:

Clase All But This

169 5 Commerce Ave
Float
Anydty WI 28383

E Mew Horizontal Tab Group

Display Compare History Transactions Customer Contract

[T Mew Vertical Tab Group

Detal  Balances Chart

If you have several tabs open and want to close all of them, right click on the tab that you want to
remain open and select “Close All But This”

Caselle Connect® ~ > Accounts Payable = > Vendor Inquiry

(Caselle Connect® | Customer Inquiry || Customer Inquiry || Purchase Order Inquiry || Vendor Inauiry [l Account Inouire | Journal ing:
Il h d d =l Il |
Vendor: Close
Close All But This
100 Ace Lumber & Hardware Balance:  3,286.87

489 Parkway Unit # 3 Contact: Float

PO Box 647 Fhone 1 555-4448

Anydity WI 53888-0647 Fax: = New Horizontal Tab Group

........... [T] New Vertical Tab Group

It will keep the menu tab and the tab you were on open.

Caselle Connect® » » Accounts Payable - > Vendor Inguiry

[ Caselle Connect® | vendar Inquiry |;||

Vendor: |
100 Ace Lumber & Hardware Balance: 3,2
439 Parkway Unit # 3 Contact:
PO Box 647 Phone 1: 555
Anycity WI 58835-0047 Fax:

EPurchaseOrders Invoices Checks Totals
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Search Screens

In any inquiry or modify screen, the advanced search can be accessed by clicking on the # or
pressing F9.
* Type in the search bar, it searches on all fields displayed
» Just start typing the wild card is assumed
* Add additional fields
* Right click on the header > Select Column Chooser from the menu
» Available fields depend on the quick search that was selected.
+ Example, select Address 1 from the Column Chooser. If the utility uses the Address
1 for additional names, they can now search for the additional names.

@ Search x
{77\ Enter a search phrase or select from the Ist.
‘lsm' Print
Hame Address1 | Customer Number Service Address Finai Bl Date
Smith, Dr. Ronald T. 665 E Parkway 110401 | 665 E Parkway Pariowa
Richardson, David T, Marcia Smith 214501 865 Palisades Dr Paisade
Smith, Judy 555 Oak Hills Dr 215501 555 Oak Hills O Oak Hils
Smith, Jason 555 Oak Hills Dr 215502 555 Oak Hills Dr 4/15/2015 Oak Hile

51 Sort Ascending
£ || Sort Descending

Clear Sorting
Hide This Column
.-@] Column Chooser
=
Best Fit (all columns) Address 2
7 Filter Editor... Alert Message
Show Find Panel Alternate Address 1
Show Auto Filter Row Alternate Address 2
Restore Default Layout Alternate Address Date
Save Layout Alternate City ©

10
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Filters can be used to refine your search as well.
Hover over the column header and click the filter icon that appears in the upper right corner.

| Customer Number ©

Once the search criteria gives the results needed, the results can be printed by clicking the Print
button next to the search field.

Print
nszo21 Search Page: 1
Name Cosigner Customer Number Service Address Final Bill Date Street
Anycity School District - High School ABC Managem 2171011617 S Lake R4 Lake Rd
Anycity School District - Middle School ABC Managem 2172011837 5 Lake R4 Lake Rd
snycity School District - Elementary ABC Managem 2172011875 S Lake Rd Lake Rd

11
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Printing/Print Preview

When you choose print from the search screens or print preview any report, the preview screen comes

up.

File View Background

o dleB|[@ehEAu-|Oalav Ha|ud

[F- = G]8 = |-

VendorType | Rating

Normal
480/ State Bank Card Normal
490/ State League of Cities & Towns Normal
510/ State Retirement Systems Normal
520| State Water Quality Division Normal
610 Workers Compensation Fund Normal

There are many things that you can do from the preview screen.

Buttons Title Functionality
2] Thumbnails Shows a thumbnail of each page in a panel on the
- left
fry Search To search the document.
53] Print Options * To change option & behavior settings for the print
- out.
= Open To open saved preview files (*.prnx)
i~ Save As To save a preview as a *.prnx file
= Print To select a specific printer
= Quick Print To print to the default printer
Ly Page Setup To change paper size, orientation and margins
= Header and Footer To modify the Header and/or Footer of the report
P~ Scaling To adjust the report by percentage or pages wide
&M Hand Tool
@ Magnifier To magnify the report
&L | 100% @, Zoom Zoom in or out on the report
| d b B Previous, Next, First | To move around in the report a page at a time or
or Last go to the beginning or end
. Multiple Pages To display more than one page
=TI Color To add color to the background of the page
B Watermark To add a watermark to the report (either text or a

picture
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\Iua = -3 Export Document To save the document as one of the 10 file types
~  PDF File H
HTML File IISted
MHT File
RTF File
DOCXFile
XLS File
XLSX File
CSV File
Text File

Image File

kie; Send via Email To send the document as one of the 9 file types

MHTFile Iisted

RTF File

DOCX File
KLSFile
KLSX File
CS5V File
Text File

Image File

& Exit To close the preview

*Print Options

92022 Search
| VendorNumber Name VendorType | Rating

380 Postmaster Normal u

480 State Bank Card Normal u

490 stat &Towns  Normal u

510 stat Normal v

520 stat Normal u

610 Wor Normal u

Print Settings (Grid View)

[ Optons [Behavor

Fio M & GansfCereds | $10.20

Ravioli Angelo < Grains/Cereals $19.50
Camenbert ierot 3 DaryProducts | §34.00
5 AX=$53.00
[ evenRon Appearance Discontinued: Checked
Tofu & Produce $2325
[E) & oddRow appearance Mascarpone Fabioli ( Dary Products | $32.00
[ [ selectedrons s2.95
(Cox concel | [ apply |
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Setup/Modify a Checklist

Use the toolbar to add a new checklist or modify an existing one. The following provides a guide to using the
toolbar:

The Create a New Item button allows for the following items to be

Create a New ltem &~ added.

1. Create a New Checklist 1. Creates a completely new checklist.

2. Create a New Group 2. Creates a new grouping within the selected checklist.

3. Create a New Task 3. Creates a new task within the selected group or checklist.

PE The Delete the Selected Item button allows for the following items to

Delete the Selected ltem be removed.

1. Delete the Selected 1. Deletes the selected checklist and all items within it.

Checkilist

2. Deletes the selected grouping and all items within it.
2. Delete the Selected

Group 3. Deletes the selected task.

3. Delete the Selected
Task

T The Copy the Selected Item allows for a task, group or even entire
Copy the Selected ltem checklist to be copied. The new item will have the same name with
the pretext “Copy of”.

Add the Selected Checklist to This button allows you to add multiple checklists to your checklist
, , selection box. When you have multiple checklists you can navigate
My View List =& . . >
between any that have been included in your view list.

Remove the Selected Checklist This button allows you to remove a checklist from your view list. If the
checklist is being used by another user or you do not want to delete it,

: . =
from My View List this option is useful to remove additional checklist from your view list.
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Set the Selected Checklist as This button allows you to select which of your checklist you would like
@ to be defaulted into your view list selection and therefore viewable
My Default when you open your checklist. The checklist on the right will have a

checkmark on the clipboard icon when it is designated as the default.
If the checklist selected to be a default is not included in your view list
it will be added.

Move the Selected Group (or These buttons allow you to move a selected group or task within a
particular checklist. The grid to the right will help you keep track of
where the item has been saved.

Task) Up/Down

Export the Selected Checklist This button allows you to export a checklist. You can export checklists
| to save them as a backup or share them with other Caselle users
] outside your organization.

Bl This button allows you to import a saved checklist. Import a checklist
that has been backed up or created by a user from another
organization.

Import a Checklist

Groups

Tasks on a checklist should be grouped according to the frequency that they should be completed. Use the
Group section to determine the frequency for the tasks included within the group. Create a frequency that is
daily, weekly, monthly, yearly, or on a special date such as a check issue or period end date.

Tasks
Use the Task section to describe a task or setup an action that should occur when clicking on the task.

* The description should give a clear direction of what the task is. For additional information, the notes
section can be filled out.

» Designate if the task is required or not. All required task within a group must be completed before the
group will proceed to the next due date.

» Designate if click on the task will open a routine within Clarity, launch another program, or just be for
information only.Checklist — Sharing
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Need for a group of users to share a checklist or just want to pass the responsibilities onto someone else? Use
the Share with All Users button to designate who can see what checklists and if they can edit them.

* Unselect the Share this Checklist with All Users checkbox to designate specific users

*  Use the grid of users to designate which users will share the checklist and which will have the ability to
modify

» If you are sharing the checklist with all users, you can also select to allow all users to be able to modify
it

16



’ civicsystems

strong software, strong community

Favorites

Favorite can be used like bookmarks in internet browsers. When you are on a tab that you want to
have a shortcut for, hover over the Favorites tab and click the star ***' to add.

File Edit Search Filters Settings Document Management Zoom  Help

Close | &4 | [ 773 Y-E-e | @@

Caselle Connect® + » Accounts Payable + > Vendor Inquiry

[ caselle connect® ‘|\4 vendor Inquiry Q] Favorites [

vendor: Vendar g Add Vendor Inquiry to Favorites
100 Ace Lumber & Hardware Balance:  3,286.87

439 Parkway Unit = 3 Contact:
PO Box 847 Phone 1: 555-4449
Anycity WI 888838-0647 Fax:

{Vendor | purchase Orders  Invoices Checks | Totals

Vendor  Entry Defaults Additional Fields Remittances Recurring Invoices  Direct Payment  Attachments  Notes

Email: Alert message:
Viebsite:

Vendor type: Normal

Activation date:

Termination date:

(saluon?j)‘\f\‘“ SpseL am:vlg‘w B E ‘

As you add to Favorites, the list of shortcuts will grow:

Fawaorites |£|

'-\;1{ Remove Account Inguiry from Favorites

Vendor Inquiry

(o]

— 4
Aocounts Payshle [ |
Employee Inguiry [«] ;
Payrall EI
Account Inquiry IZI ;
Genara Ledger [+]

You can use the up and down arrow keys to put your favorite in the order you prefer.
You can remove shortcut from your Favorites by clicking the Star for the tab you are on or
clicking the X.
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Active Tasks

The third tab on the right is the Active Tasks. If you like to keep all the tabs you use during the day

open, Active Tasks will allow you to go to any tab whether they

are showing on the top or not.

If you have more tabs open than will fit in the window, arrow keys will appear on the right side.

File Edit Search Filters Settings DocumentManagement Zoom  Help
Close |88 |15 @&- 3 V- 82- 9| @@
Caselle Connect® + > Human Resources - > Job Posting Inquiry |
[vendor Inquiry || Employee Inquiry _|[ Account Inquiry | Journal Inquiry || Inquiry || Assetinguiry | Receiptingury | Employee Inquiry | Applicanti ] [<][>] g
. ol
Reference; | [Reference VM4 of2 LI
Job posting:  Building Inspector-Bld, Building Inspection (BI100) Opened date:  03/30/2015 Positions opened: 1 %
Position type:  Full time Closed date:  08/29/2015 Fositions filed: 0 e
Filled date: Ll
Job Description  Applicants  Additional Information  Attachments Motes z)
Name Gender Ethnicity City Telephone 1 1}
= |
Black, Lane Male Anyeity (385) 555-3205 2
Elison, Ray Male Anycity (385) 555-5510 —
)
Mchiei, Anrie Female Anyeity (385) 555-4785 o
!
P
3
2)

These can be used to move through the tabs, but using Active Tasks will help you find the task you

want quicker.

File  Edit  Search

Filters  Settings Zoom  Help
Close éﬁ j @' E ?'E' '@ @@

Caselle Connect® =~ > Human Resources - > Job Posting Inquiry

W

|’ Vendor Inquiry || Employee Inquiry || Account Inquiry ” Journal Inquiry || Inquiry ” Asset Inquiry || Receipi| Active Tasks El Q‘;
Reference: ‘ Reference = Caselle Connect® “9
Caselle Connect® 2
Job posting:  Building Inspector-Bld, Building Inspection (BI100) Opened date:  03/30/2015 %
Position type:  Full time Closed date:  08/29/2015 E] Accounts Payable —_—
Filled date: Vendor Inguiry Wl
Job Description  Applicants  Additional Information  Attachments  Notes = Accounts Receivable Y
) =
Name Gender Ethnicit Inguiry L
o
Black, Lane Male 8 i:::ttl:muli:agement &
Ellison, Ray Male quiry =
McNeil, Annie Female B Cash Receipting 5—2"
Receipt Inguiry &
2
= General Ledger §
Account Inquiry ‘i

Applicant  TaskLists Tests Qualifications

References  Motes
Ranking: 1]
Application date: 03/30/2015
Resume received date:  04/13/2015
Interview date: 04/22/2015
Available date: 04/29/2015
Reply date: 04/18/2015
Desired wage:
Status:

Journal Inguiry

= Human Resources
Applicant Inquiry

[ Payroll
Employee Inquiry

= Timekeeping
Employee Inquiry

[ utility Management
Customer Inquiry
Customer Inquiry
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Reports

Default Reports:

The report that is used most often can be set as the default report. In the new style reports click the

options icon #1 and select the report from the Default report dropdown list. Click OK and click
Save for the entire organization.

%7 Options x
Default filter: | All ”
Default report: | Aging Report - Demo » B Save Options X

Aging Report - Al 's Report .
e et How do you want to save these options?

port - Demo
Aging Report - by Collection Code [Caselle Master]

Help Aging Report - by Customer Name [Caselle Master] =1 . N
Aging Report - by Customer Number [Caselle Master] _] Save them for the entire organization
#7] Options X g
& Save them for me only
Default filter: | Al v
Defaultreport: | Aging Report - Demo “ Cancel
Help oK Cancel

For the old style reports, have the report displayed in the Title box and check the box Default report:

|§ Caselle Connect® || Accounts Receivable by Service. .. |;||| Aging Report || Biling Exception Report |

‘ Title: | coounts Receivable by Service Report - by Customer Mumber [Caselle Master V| [ ] Default report

Report Filters & Default Filters:

As your utility gets more and more reports setup, you may want to create a filter to filter out the
specific reports that you use for report.

To setup a filter, click on the filter icon and Manage Filters will open:
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Caselle Connect® ~ > Utility Management ~ > Reports + > Meter Reading Exception Report

[ Caselle Comnect® || Meter Reading Exception Repart ‘

Definition: | Meter Reading Exception Report - by Customer Number [Caselle Master] w | Filter: |Caselle Masters v %M o4 of 2
Report Options
P P ¥ Manage Filters *
Report dates! .
| Filter name: 5 X
From: Uf Consecutive Reports e
Toi u: Filter name: |Consecuh've Reports v |
[ Cheek 2 Pjeport definitions: ]
[ tnclude or [ [=] | . . Definition . ‘ LastProcessed |
Exceptions to Meter Reading Exception Report - 3 Consecutive Period Mo U...
[] Meter Reading Exception Report - by Customer Number [Cas... 06/08/2022
[[] Meter Reading Exception Report - by Read Route [Caselle M...
ding Exception Repol stimates
Inactiv
O [] Meter Reading Exception Report - Estimated Reads 06/08/2022
Exact
act [[] Meter Reading Exception Report - High Low Report 05/17/2022
L] Meter y [[] Meter Reading Exception Report - No Consumption 06/07/2022
[ Meter 5 [7] Meter Reading Exception Report - No Reads - Inactive with U... 06/07/2022
[] Meter Reading Exception Report - No Reads - Sewer Deduct  06/07/2022
[] Meter Reading Exception Report - Rollovers 06/07/2022
Meter d Help OK Cancel
(BN | Vo e ——

Enter the name of the filter and check the boxes before the reports you want to see. You can
filter by type of report or use your name to identify they are the reports you use.

File Edit Filters  Settings

xED&L v E- ek

Zoom  Help

Close

[ Casele Connect® 1 Meter Reading Exception Report Q|

Caselle Connect® ~ > Utility Management ~ > Reports = > Meter Reading Exception Report

c

Definition: | Meter Reading Exception Report - No Reads - Inactive with Usage - Water | Filter: | Al v %A |6 ‘ of10 b bl
Report Options | Additd 7 Manage Filters X
Report dates Filter name: y y
. x| 2 | X
From: |04/02/202 | Consecutive Reports
RCIRI7VEY-I il Variance Reports - Therese Fiter name: [variance Reports - Therese |
Report definitions:
[Jcheck 2 cons| - i <
O | [=] Definition Last Processed
I”df*de °”';°::"ﬁ W] | Meter Reading Exception Report - 3 Consecutive Period No U...

Exceptions to che [[] Meter Reading Exception Repart - by Customer Number [Cas... 06/08/2022

Active with no ri [] Meter Reading Exception Report - by Read Route [Caselle M...

[ Active with no u [[] Meter Reading Exception Report - Consecutive Estimates

Tnactive with usq [] Meter Reading Exception Report - Estimated Reads 06/08/2022

[ Exact same usar Meter Reading Exception Report - High Low Report 05/17/2022

[ Meter with a reg Meter Reading Exception Report - No Consumption 06/07/2022

[ Meter activity w Meter Reading Exception Report - No Reads - Inactive with U... 09/08/2022

Meter Reading Exception Report - No Reads - Sewer Deduct 06/07/2022
Meter Reading Exception Report - Raollovers 06/07/2022
Help oK Cancel
D Meter usage oul

Once you have filters setup, you can setup a default filter by clicking on Options and selecting

the filter you want to use.
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File Edit Filters Settings Help

s xBH D E6E9 Y 8-

Zaselle Connect® ~ > Utility Management - » Reports =~ > Meter Reading Exception Report

“Casele Connect® 1 Meter Reading Exception Report I:I\|

Zoom

Close

Definition: | Meter Reading Exception Report - No Reads - Inactive with Usage - Water ~ | Filter: | all ~
Report Options  Additional Options  Columns  Print Sett
B 3 Options >
Report dates
From: |n4/02/2022 - 4| | Default filter:
To:  |07/01/2022 g ik Defaultreport: |- celle Masters b
ad d oot Consecutive Reports
Wanced oplons... Help Variance Reports - Therese
[ check 2 consecutive periods

= Optiens X
Default filter: Variance Reports - Therese hd
Default report: | Meter Reading Exception Report - Mo Reads - Inactive with Usage -

Help oK Cancel

This is one of the rare times we recommend that you “Save them for me only”

[=] save Options *

How do you want to save these options?

==
; J Save them for the entire organization

£ Save them for me only

Cancel

Drill Down Capability

The new style reports have drill down capability if the reports are previewed. If the report lists

customers, click on the customer number or name to go to Customer Inquiry.

If the report is

made up of different totals, clicking on a total will bring up a second report to show what customers

made up that total.
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‘Anycity Corporation Transaction Summary - Page: 1
Dates: 04/01/2020 - 04/30/2020 Sep 14, 2020 11:304M

Report Criteria:
Selected types: Billing, Billing Adjustment, Gontract Adjustment, Gontract Billing, Deposit Applied, Interest Applied, Payment, Payment Adjustment, Reallocation, Transfer, Write OF
Suppressing rows with no transacions
Summarized by calendar day

Billing Contract Contract Deposit Interest Payment Write
Date Billing Adjustment Adjustment Billing Applied Applied Payment Adjustment Reallocation Transfer Off Balance
03/31/2020 3,068.29
04/02/2020 42585 - - - 100.00- 8.33- - - - - - 3.002.51
04/03/2020 - - - - - - 191.81- - - - - 2,810.80
04/15/2020 40.00 - - - - - - - - - - 2,850.90
04/20/2020 - - - - - - - 100.45 - - - 2,951.36
04/29/2020 - 30.00- - - - - - - - - - 2,921.35
04/30/2020 58.30) - - - - - 34.45- - - - - 2,9458.20
Grand Totals:
141.8 30.00- - - 100.00- 8.33- 228.07- 100.46 - - - 2,948.20
wmycity Conporston Transaction Register - 5YSTEM STATUS REPORT DAILY Fage 1
=: 04/15/2020 - 04/ 152020 Sep 14, 2020 11:324M
Report Criters
Selected tvpes: Biling
Billing
04/15/2020
Customer Refarance Check
Name Number Type Mumber Diescripfon Source ID Numiber Amourt Msg Servie
illan, Cynthe y 2.153.01 Billing 2 Manual Billing 1500 M MNEF-14
Bates, Willam 5. 2.145.01 Billing 1 2500 M Misc- 13
Total 04/15/202 a0z 000
Total Billing: 40.00
Grand Totals: 40.00

Report Criteis
Selected tvpes: Biling
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Creating User Defined Fields

User Defined Fields (UDF) can be added to any table in any application. They are used when you want to
track or report on information that does not already exist in the table.

User Defined Fields are added in Organization > Organization on the User-Defined tab in all applications.

When a UDF is added

e Select the table to add the field to
o Enter the name of the field. The name must be unique and cannot be the same as an existing
field in the system.

e Select the Type
o There are 4 types of fields that can be added.

Date

Organization - » Organization

teading Exception Report__ || Organization [J|

y Certification Conservation Stock Certificates Interfaces Notifications Passwords Tracking User-Defined ng

& Setup New User-Defined Field x
Work Phone Table: | Meter v
Contact Name Name: ‘Test Date|
Veteran
Type: | Date ~
Senior Citizen
Employer Validation
Paperless Bil? Mask: MM/ddfyyyy e.g. 03/08/2022
Propert @D | pegrying ange:
Buffalo Box
Endi :
Purchase Date neing range
EMR Date Default value:
Battery Date Allow blank dates
Scrap Date
Test Date
High Test Read
Low Test Read
Read Frequency
Help oK Cancel

Number

> Organization

e Reading Exception Report__|| Organization (|

- > Organization

Pay Certification Conservation Stock Certificates Interfaces Notifications Passwords Tracking User-Defir

& Setup Mew User-Defined Field

x

Work Phone Table: | Meter
Contact Name Name: [BLOC |
veteran

T Type: |Mumber
Senior Citizen

Employer Validation

Paperless Bill? Mask: |¢¢:,¢¢:,###,:#¢J-:##,###,::‘r: e.g. 1,234,568
P tax ID

roperty t2x Begrningrange: | |

Buffalo Box

Battery Date

Scrap Date

Test Date

High Test Read

Low TestRead

Read Frequency
Help

oK Cancel
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Text

> Organization = > Organization

er Reading Exception Report i Organization \:I‘|

Pay Certfication Conservation Stock Certificates Interfaces Notifications Passwords Tracking User-Defined notes

| F‘e'di & Setup New User-Defined Field x|
Work Phone Table: [Customer o
Contact Name
Veteran Name: [Sort Code
Senior Citizen Type: | Text ~
Employer Validation

Paperless Bill?
Property tax ID

Length: 1 z

Buffalo Box Additional validation: | Self validating ~

Purchase Date Self validating Add Value
EMR Date Spedific values onl:

Battery Date

Serap Date Set Default
TestDate Remave Value
High Test Read

Read Frequency
Help oK Cancel

Text fields can have validation
¢ None means it’s a free form field. You can enter anything you want.
¢ Self-Validating means you can enter any text you want and it will be
available to pick from the list in the future.
e Specific values mean you enter the only values allowed in a pick list

Yes/No

> Organization ~ > Organization

= Reading Exception Report || Organization [ﬂ

Pay Certification Conservation Stock Certificates Interfaces Nofifications Passwords Tracking User-Defined piotes

| F‘a'di & Setup New User-Defined Field x
Vierk Phane Table: | Customer ¥
Contact Name

Veteran Name: [Email Gl

Senior Citizen Type: |Yesmio

Employer

Paperless Bill?
Property tax ID
Buffalo Box
Purchase Date
EMR Date
Battery Date
Scrap Date

Test Date

High Test Read
Low Test Read
Read Frequency
Help OK Cancel
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Deleting History

Occasionally you will want to delete history from prior to your retention period. All applications have
retention period setup in Organization > Organization. Depending on the application, the retention

period may be days, months or years. All history or just certain detail like payment detail or expired
licenses

Keep X years of history:

Caselle Connect® = > Accounts Payable - » Organization = > Organization

|J Caselle Connect® || Vendor Inguiry || Meter Reading Exception Report || Organization [

General Interfaces Purchase Orders Override Users  DirectPayment Passwords Tracking User-Defined MNotes

Primary name: |.-'-\ny'city Corporation | Employer ID: §7-0001111

Secondary name: | | Keep years of history
A T 1 —

Accounts Payable

Asset Management

Business Licenses

Business Tax Collection

Human Resources — Payroll history
Materials Management

Payroll

Project Accounting

Timekeeping

Keep X months of history:
Caselle Connect® |»(> Accounts Receivable ~ > Organization - > Organization

|’ Caselle Connect® || Vendor Inquiry ” Meter Reading Exception Report || Organization || Organization I:I\

Organization Interfaces Passwords Tracking User-Defined Motes

Primary name: |Anydty Corporation | Customer number format: |¢¢¢¢¢ |
Secondary name: | | Keep months of history

Accounts Receivable
Backflow Management

Keep expired licenses for X months

Caselle Connect® - > Animal License - > Organization -~ > Organization

( Caselle Connect® ] Organization I:I|

Passwords Tracking User-Defined Motes

Primary name: |.-'-\nycity Corporation Keep expired licenses for EI months
- T 1

Animal License
Community Development
Maintenance Orders
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Keep payment detail X days

Caselle Connect® :> Cash Receipting ~ > Organization ~ > Organization

|' Caselle Connect® || Organization |:|‘|

Primary name: |.ﬁ.nycitv Corporation Keep payment detail days

Cash Receipting
Check on Demand
Human Resources — Applicant history

General Ledger — Years of detail, period summary or annual summary

Transaction history
Years of detail:
Years of period summary: |3
Years of annual summary: |5

Budget history
Years of detail:

Years of period summary: |3

Years of annual summary: |5

Utility Management — Keep X Periods

Delete account history after periods
Delete meterfservice order history after periods

Deleting History tasks are commonly found in the Organization Miscellaneous Menu. Although they can
be found in other menus, for example Delete Inactive Customers in Accounts Receivable and Utility
Management is in the Customer Menu.

The Delete History function will use the retention period in Organization to default the date to “delete
records dated on or before:” DO NOT CHANGE THIS DATE unless it is to a date prior to the date listed.

Delete history functions will also allow you to add some selection criteria to limit the history being deleted.

You can normally select Print Report Only to get a list of what will be deleted without actually deleting
anything. When you want to run the Delete, uncheck that box.

Delete history functions will not allow you to delete active records.

NOTE: ALWAYS MAKE A CURRENT BACKUP BEFORE RUNNING A DELETE HISTORY PROCESS!
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Example:

Eile Zoom Help

CIose||E||‘?|k?

Caselle Connect® « > Accounts Receivable + » Customers = > Delete Inactive Customers

|’ Organization || Organization || Organization || Organization || Organization || Organization || Delete History || Delete Inactive Customers QI_
’j Make sure you have a cumrent backup before proceeding.
.

Use this routine to delete customers who meet the following criteria:

» Temination date iz on or before the date entered
» Customer balance is zero

+ Customer has no transactions after the date entered
» Customer has no open deposits

Delete customers with no activity since: | \EJE

Print report only

Selection criteria:

Column Value
Customer.Customer number All

Need more help? Civic Support Line: 888-241-1517
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